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LISA: A REVOLUTIONARY PERSONAL. (OOMPUTER FOR THE OFFICE

Lisatm, Apple Camputer's new personal computer for the office,
introduces a new kind of relationship between the user and camputer. Instead of
having to adopt rigid conventions and special languages, the user works
naturally with familiar objects and tasks represented as pictures on Lisa's
screen.

Apple's goal was to create a personal computer that would maximize office
performance without requiring the user to sacrifice familiar work habits. John
Couch, vice president and general manager of the Personal Office Systems
Division, describes Lisa's development this way:

"The office is not a place; it's a oollection of people. Apple looked
within its own offices to examine the procedures and information everyone uses.
We felt that if we ocould design products useful to us, they would work in other
offices as well. It's the individual-centered approach, we think, that sets
Apple apart."

But first, Apple examined why personal computers had not yet fully
penetrated the office market. Research indicated that personal computers were
often difficult and time consuming to learn (and, therefore, expensive).
Additionally, they were "single-minded"—they didn't allow people to move data
easily from cne application to another, nor to transfer information fram one
user to another.

Thus, Apple set out to develop a personal computer that was extremely easy
to use and easy to learn, that had the ability to transfer data between
applications and between users, and that allowed users to run existing programs
and write new programs in widely used, high-level languages and operating

systems.

-
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The result was Lisa, a personal computer that Apple feels will set the
standard for office systems for the next five to ten years. Lisa employs
advanced software and hardware technology, makes extensive use of graphics, and
uses the same basic functions to operate all its integrated applications. Lisa

is so easy to learn that a user can be doing useful work in under 30 minutes.

How Lisa Works

Lisa utilizes a "mouse," a palm-size device that positions the aursor, ar
pointer, anywhere an the screen. By noving the mouse on the desktop, the user
points to and selects dbjects an the screen.

The Lisa screen features graphic representations of dbjects—stationery,
clipboard, wastebasket, and more—typically found in an office environment.
These pictures also represent tasks—writing, setting aside documents an the
desktop, putting documents back in folders, or throwing documents away.
Collectively, these dbjects form the "desktop manager," the part of Lisa's
software architecture that organizes information, documents, and tasks just as

the user would in a typical office.
(See Figure 1)

The menu bar, a component of the desktop manager, is always visible at the
top of the screen. It changes autamatically with each application and informs
the user of the options available in that application. After making a selection
from the menu bar, additional options for performing specific tasks are offered

through a pull-down menu.
(See Figure 2)

s
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All of Lisa's software programs can be stored on the ProF‘iletm mass
storage system, allowing the user to run applications concurrently and to go
from ane to another without rebooting diskettes. Although the user can work with
only cne application at a time, all applications can be viewed on the screen
simultaneocusly—just as real documents can be spread ocut on a desk. Instead of
being oconcerned about what application to use, the user merely selects the
desired document; Lisa does the rest.

The following paragraphs illustrate how a manager would use Lisa to
accomplish a series of tasks. He moves easily between LisaWritet'm,
LisaProjecttm, IdsaCalcm, LisaGIaphtm, LisaDrawtm, and
LisaListtm in succession.

The most common office task, writing a letter, begins by opening the
stationery folder. Using the mouse, the manager points to the picture of the
stationery folder an the screen and clicks the button an the mouse to select the
folder. Several selections appear on the menu bar. He chooses the File/Print
menu and opens it by holding down the button on the mouse. The pull-down menu is
displayed and additional options are listed, one of which is "Open Stationery."
With another click of the mouse hbutton, the stationery folder is opened and the
contents revealed graphically an the screen. If the manager wants to refer to a
previcusly prepared document, he chooses the "ProFile" cbject fram the desktop

manager and scans the information that's an file.
(See Figure 3)

For exanple, let's consider a document called Opus Project schedule. First,
the manager cpens the File/Print menu, views the choices listed on the pull-down
menu, and selects "Open Schedule." Only a small part of the project is revealed.
To view the rest, he can open the Page Layout menu, select "Reduce to Fit" fram

the pull-down menu, and the entire schedule is displayed.

— o5
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On the screen are circles that indicate project milestones, and boxes that
represent tasks to be completed. Inside each box is the name of the task, the
person responsible for it, and how long it will take. Underneath each box is the
latest date on which the project can be started if it is to be campleted on
time, and the latest date on which the task can be completed if the project is

not to be delayed. Lines between tasks show their interdependency.
(See Figure 4)

With the mouse, the manager can add tasks to the chart by drawing boxes and
entering in each box (via the keyboard) the name of the new task. Lines
connecting the previous tasks can be deleted and new cnes drawn in. Lisa
automatically charts and highlights the critical path, aalculates the results of

any changes, and updates the chart.
(See Figure 5)

Lisa gives the manager the flexibility to alter the chart—to find aut in
advance what to expect if new assignments should come up or if tasks are not
completed on schedule. For example, if the manager has assigned Robert a new
task and given him six days to ocomplete it, he can see how this new job will

affect Robert's work load by viewing a resource chart.
(See Figure 6)

The chart shows that Robert is overbooked, but Steven has extra time. The
manager can balance the workload by reassigning the task fram Robert to Steven.
Again, Lisa does all the updating and calculations. The manager also can keep
track of how the project is progressing by entering the remaining days for each

task. The resource chart is updated autamatically with each change.

e 85
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InterOffice Memo O
To: Marketing Council
Re: Opus Project Budget
From: Leo MacMillan
Here 15 8 summary of the budget for the Opus Project for the calender
year 1983, Please note that despite & large 1ncrease 1n expenses 1n the
third guarter, we still have menaged to stay within our proposed budget.
Opus Project
Excess or
TOTAL Budget Deficit
164.8% 200.00 35.15
197.83 27500 77.17
390.64 375.00 (15.94)
498 .37 550.00 31.63
$1,251.99 $1,400.00 § 148.01
An organization chart of the people working on the project is svallable
upon request. Please contact me with your comments. I look forward to dJ
seeing you at Tuesday's meeting at 9:00 1n Conference Room A. (o2
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Let's move an to the Opus Project budget. Using the mouse, the manager
opens ProFile from the desktop manager and selects the hudget. Again, all or
part of the budget can be displayed on the screen. To change a value, he points
to the appropriate colum and presses the mouse button to select it. The new
value is typed in fram the keyboard. Revising a model is easy because Lisa

automatically recalculates the entire chart.
(See Figure 7)

Our manager can easily insert the budget into a memo or report. He makes a
copy of the budget and sets it aside an the screen; then he writes the memo
which is also displayed on the screen. With the mouse, he positions the pointer
at the location in the memo where he wants to insert the budget. From the Edit
Menu, he chooses an option that autamatically "pastes" the copy of the budget
model into the memno.

Text, such as the heading "Opus Project" above the budget model, can be
entered in the same manner. It can be centered, boldfaced, italicized, and nore.
Lisa provides options that allow a document to look just the way the manager

wants it.
(See Figure 8)

For budget information that is dbvious at a glance, cur manager creates a
graph. He selects information from the original budget, copies it, and inserts
it into the graph application by using the "Paste" option fram the Edit menu.
Lisa draws the graph automatically. Options include a bar graph, line graph,
bar/line mixture, scatter graph, or pie chart, plus a variety of typestyles and

sizes for titles.

(See Figure 9) 10_ ‘5
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In same instances, the manager may need a custam drawing to further
illustrate the information. With Lisa, neither an artist nor drafting table is
needed. From the Edit menu, the manager selects the "Copy" option and the graph
is duplicated. Using shapes and free-form graphics, he now can work with the
copy to create a custam graph. On the screen is a customized pie chart of the
Opus Project budget. Sections an be separated, duplicated, or shaded with
different fill patterns. These cbjects can be rearranged to produce a drop

shadow, or lines can be drawn and boldfaced. Text also can be added and moved.
(See Figure 10)

With the schedule, budget, and graphs finished, ocur manager may want to
send his documents to a list of people. He opens a document that contains a list
of all the employees in the company——their names, mailboxes, departments, and

other information.
(See Figure 11)

Suppose he wants the report sent to everyone on the marketing council. When
he selects the "Find What" option fram the List Menu, the manager is presented
with a search specification table ocontaining the column headings fram the
employee list and cne blank row. He would then go to the Marketing Council

colum and type the word "yes" in the blank row.
(See Figure 12)

After selecting "Find and Show" fram the List Menu, cnly the names of those
employees an the marketing council appear cn the screen. If only part of the
employee information on the distribution list is needed, such as names and
mailboxes, the manager can select the "Order and Format" option and type a "no"

in all the oolums of information not needed. Lisa autamatically revises the

—~more—- ’ 2“—' l 5
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Adams, Mike 1-§ Facilities ino no ;
Agtang, John 5-R Service no ‘yes
Bloomfield, Jim (3-I Engineering ino :no
Chavez, Steve 8-E ‘Admin yes yes
Childress, Bonnie :4-E :Distributionino ‘yes
Cunningham, Dave ;B-W iMallroom no ino
Day, Bob 1-D Accounting ives yes
Durk, Edwina 4-E Pubs iyes :no
Eestwood, Donna  (G-D Purchasing :ino iyes
Eilers, Wayne 1-D Engineering :yes no
Emani, Donald IR Marketing  iyes :no
Goodmen, Conway :9~G Persannel no :no
Gregory, Jim 4-D Traffic no ‘no
Gustavo, Mark 4-S Payroll no ino
Hillman, L1z 7-R Admin ‘no ‘no
Hopf, Jennifer -7 Accounting ino no
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list to show anly the information specified.

(See Figure 13)

When the work is ocomplete, the manager returns to the File/Print menu,
opens the stationery folder, selects an empty folder, and names it "Opus

Project." He now files all the Opus Project documents in cne folder for easy

access later an.
(See Figure 14)

Lisa's other functions are Jjust as comprehensive and easy to use as these
applications. The keyboard features a mumeric keypad for calculator-style entry
of numbers, and standard characters that can be shifted to mathematical symbols
or foreign characters. Presentation—quality printouts reflect what appears on
Lisa's high-resolution screen. Manuscripts, schedules, graphics, charts, and
designs can be reproduced on paper with Apple's Dot Matrix and Daisy Wheel

Printers.

4—15
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